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Chapter |

Introduction

This manual shows you how to use the Dolby Atmos® Designer software to configure and
tune an auditorium in a Dolby Atmos Cinema Processor CP850 playback environment, or
a postproduction mix stage when using the Dolby® Rendering and Mastering Unit (RMU).

With Dolby Atmos Designer, you can tune your auditorium or mix stage using its
automated equalization (AutoEQ) capability. This application provides tools for
measuring the response of an auditorium or room and designing and implementing an
equalization configuration. You can configure different target response curves, such as a
flat response, the standard cinema x-curve, or a custom curve. Dolby Atmos Designer
generates a Dolby Atmos configuration (.dad) file, which includes a room configuration
and other data.

= Note: You can open the .dad and .dac file formats using Dolby Atmos Designer. The
% CP850, RMU, and previous versions of Dolby Atmos Designer use the .dac file
format. Using the CP850 or RMU web user interfaces (Uls), you can restore only a
.dac file. You can open .dad files only with Dolby Atmos Designer.

Questions or Feedback

If you have questions or comments regarding this document or another related document,
please contact technical publications.

If you have technical questions regarding this product/technology, please contact technical
support.
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Chapter 2

Using Dolby Atmos Designer

This chapter provides step-by-step instructions for configuring and tuning an auditorium
in a Dolby Atmos® Cinema Processor CP850 playback environment, or in a postproduction
mix stage when using the Dolby® Rendering and Mastering Unit (RMU).

For a CP850, you install Dolby Atmos Designer on a PC or Mac®, as described in Section 2.3.
When you connect to a Dolby Digital Cinema auditorium network that includes a CP850,
you can run Dolby Atmos Designer in online mode. Dolby Atmos Designer runs in offline
mode when disconnected from the auditorium network. In offline mode, you can enter
information regarding an auditorium and save a .dad file. You can then reopen this file later
to complete the process when you are online.

For an RMU, Dolby Atmos Designer is preinstalled on the system drive, and runs directly
from the RMU.

= Note: You can open the .dad and .dac file formats using Dolby Atmos Designer. The
% CP850, RMU, and previous versions of Dolby Atmos Designer use the .dac file
format. Using the CP850 or RMU Uls, you can restore only a .dac file. You can open
.dad files only with Dolby Atmos Designer.

This chapter includes the following information:

¢ Positioning Microphones

¢ Setting Up Audio Capture

¢ Installing Dolby Atmos Designer

* Launching Dolby Atmos Designer

* Designing a New Configuration

¢ Configuring a Room

e Configuring a Speaker Location

¢ Assigning Arrays

¢ Configuring the Speaker Assignments

¢ Configuring the Routing Parameters

¢ Configuring the Bass Management Parameters
* Entering the Room Information

e Configuring the Advanced Parameters (CP850 Only)
* Tuning the Room

¢ Viewing and Editing the Database

Dolby Atmos® Designer User’s Manual 3



Using Dolby Atmos Designer

2.1 Positioning Microphones

To run Dolby Atmos Designer, you need the following equipment:

* Microphones (minimum of five, maximum of eight)

* Supported audio interface

e External sound pressure level meter

Begin the configuration by positioning your microphones:

1. Place microphone 1 at the reference position:

¢ For an auditorium, place microphone 1 along the center line of the image at a

point approximately two-thirds the length of the room.

For a mix stage, place microphone 1 along the center line of the image at the
mixing console.

Place microphones 2-8 at different positions within the room so that they cover the

middle to rear portion of the seating area. (Use the following guidelines, and refer to
Figure 2-1.) If possible, avoid the following:

* Do not place microphones 2-8 at points of symmetry. That is, avoid placing

microphones half the distance between walls (antinode for all harmonics),

one-third the distance between walls, or one-quarter of the distance between
walls.

¢ Two microphones in the same node structure: Do not place microphone pairs

with front/back or left/right symmetry. That is, avoid placing two microphones at
the same distance from a parallel wall. (For example, if one microphone is placed

15 feet from the left wall, do not place a second microphone 15 feet from the right
wall.)

* Do not place microphones close to wall surfaces, hard partitions, equipment

credenzas, or other surfaces that could cause errors in the measured frequency
response due to sound reflections.

¢ Do not place microphones in close proximity to an individual loudspeaker.

Figure 2-1 shows typical auditorium and mix stage microphone setups.
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Figure 2-1 Typical Microphone Setups
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Positioning Microphones

Microphone Angle and Elevation

Take the following precautions when positioning the angle and elevation of your
microphones:

1. Position each microphone near the typical ear height of a seated person (four feet, or
1.2 meters), but with enough distance from the seat or mixing console to prevent
frequency response errors due to sound reflections. Typically, this is six inches or
15.24 centimeters above a seat in a cinema or screening room.

2. Orient each microphone so that the sound arrives along the axis where the
microphone exhibits the flattest frequency response.

For example, point each microphone at a 45° angle toward the screen speakers when
using Beyerdynamic MM 1 microphones with serial numbers greater than 2000.
However, when measuring surround and overhead speakers, point each microphone
straight up toward the ceiling, due to the different incident angles to the microphones.

Caution: High-back chairs can prevent you from placing a microphone near the ear height
of a seated person. In such a case, elevated seated ear height is desirable to avoid
frequency response errors that result from sound reflecting off the seat.

4 (1.2m)

6" (15.24 cm)
) R

Figure 2-2  Microphone Relative to Seated Person Ear Height
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Using Dolby Atmos Designer

2.2

Setting Up Audio Capture

You continue the room configuration by setting up audio capture using the appropriate
audio interface:

¢ For a CP850 auditorium environment, use the Roland® Octa-Capture high-speed USB
audio interface.

Note: For Microsoft® Windows®, you must set the Octa-Capture audio buffer size to 512
for the driver settings.

* For an RMU mix stage environment, use the RME Micstasy audio interface.

The following figure shows you how to set up audio capture in a CP850 auditorium or an
RMU mix stage. For detailed instructions, see the documentation included with your
respective equipment.

Auditorium |  CATSE Doby e
network CP850

1 CAT5E :

D R R R - - uUsB

\/

\\\\%\%\%\%\% Microphone cable Roand

Dolby RMU

BNC

Microphone cable
ANSSNNSSNN "| R

Figure 2-3 CP850 and RMU Audio Capture Configurations
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Installing Dolby Atmos Designer

2.3 Installing Dolby Atmos Designer

For a CP850, you must install Dolby Atmos Designer on your Microsoft Windows or
Apple® Macintosh® system. For an RMU, Dolby Atmos Designer is preinstalled on the
RMU system drive.

= Note: The CP850 requires software version 2.1.0.10 or later, while the RMU requires
% software version 1.6 or later.

The Dolby Atmos Designer software runs on Microsoft Windows 7 and 10, and Apple Mac
0OS® X® v10.9, v10.10, and v10.11. VMware® is not supported. To install Dolby Atmos
Designer on a Mac or PC:

1. Download the Dolby Atmos Designer software from https://www.dolbycustomer.com.
You will need to set up a user ID and password to access this website. You can also
download periodic software updates here.

2. Double-click on the Dolby Atmos Designer icon to begin the installation process, then
follow the screen prompts.

2.4 Launching Dolby Atmos Designer

To launch Dolby Atmos Designer on a PC, click Start > Dolby Atmos Designer. On a Mac,
double-click the Dolby Atmos Designer icon. A new untitled project opens with a menu bar
at the upper-left side of the screen. You can access the populate, define, tune, and manage
parameters by clicking on the respective buttons in the navigation bar at the left side of the
screen.

El Populate Define Tune Manage

Menu bar

Navigation
bar (populate
parameters)

Figure 2-4 Dolby Atmos Designer New Project (Populate Parameters)
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Using Dolby Atmos Designer

The first parameters to appear are the populate parameters, as indicated by its highlighted
button [] in the navigation bar. This is where you begin a new configuration design.

By default, only buttons appear in the navigation pane. Optionally, you can expand the
displayed area to view button labels that identify the respective parameters. The
instructions in this manual show the navigation bar in the default button-only view.

a populate

Figure 2-5 Navigation Bar in Expanded Window with Button Labels

24.1 Using the Menu Bar

The menu bar at the upper-left side of the screen provides multiple menu options.

File Remote Edit Log Help @ Dolby Atmos Designer File Remote Log

Windows Mac

Figure 2-6 Menu Bar

File Menu

When you click File in the menu bar, you can start a new configuration, open an existing
configuration from your local disc, save your configuration settings, perform database
functions, import Dolby Atmos Designer profiles, and exit Dolby Atmos Designer. (On a
Mac, there is a Quit option in the Dolby Atmos Designer menu instead of the Exit option,
as shown in Figure 2-11.) For information on the database functions and .dad profiles, see
Section 2.6.

Ctrl+M
Ctrl+ O

Ctrl+5

write database
Import database
Export database

Import dad profiles

Exit

Figure 2-7  File Menu
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Launching Dolby Atmos Designer

Remote Menu

When you click Remote in the menu bar, you can connect to the CP850. You can also pull
or push a configuration (for both the CP850 and RMU).

Remote

Connect

Pull fron

Push to CP850

Pull from RMU
Push te RMU

Figure 2-8 Remote Menu

Edit Menu

When you click Edit in the menu bar, you can access the Preferences parameters. On a Mac,
you can access these parameters in the Dolby Atmos Designer menu. (See Figure 2-11 and
Figure 2-11.)

Log Menu

When you click Log in the menu bar, you can show and clear logs.

Clear logs

Figure 2-9 Log Menu

Help Menu

When you click Help in the menu bar (Windows), you can display Dolby Atmos Designer
software information. On a Mac, you can access this information in the Dolby Atmos
Designer menu.

HElF:

About

About |:_|t

Figure 2-10 Help Menu
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Using Dolby Atmos Designer

2.5 Designing a New Configuration

To design a new configuration:

1. If Dolby Atmos Designer is not running, launch it.
A new untitled project opens.

2. Click Preferences in the Edit menu (Windows), or in the Dolby Atmos Designer menu

(Mac).
On a Mag, also note the Quit option (instead of File > Exit, as in Windows).
About
About Qt
Pref S
rererences \
Services >
Hide 38H

Hide Others  .32H
Quit #Q
Figure 2-11 Select Preferences

The Preferences screen appears. In this screen, you can select your audio device, and
specify your measurement units (meters or feet). In addition, you can view database
information and perform database functions. If you write custom notes when exporting a
database, the database notes appear in this screen. For information on the database
functions and .dad profiles, see Section 2.6.

Figure 2-12 Preferences Screen

3. Enter your preferences, then click OK or click Cancel to undo your entries.
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Designing a New Configuration

25.1 Configuring a Room
To configure your room:

1. Click the populate D button at the left side of the screen, and then click the

- button.

File Remote Edit Log Help

ﬂ edit Click edit

Figure 2-13 Click Edit to Enter Parameters

The populate screen is now activated. In this screen, you configure the wall, floor, and
ceiling parameters by making entries in the respective fields for each area in your
room. Figure 2-14 shows the screen wall parameters, which is the first set of populate
parameters to appear, as indicated by its highlighted tab m The tab for the
active parameter is always highlighted. Before you enter valid parameters, the wall,
floor, and ceiling populate tabs include a small red icon. After configuring valid
parameters, the icons change from red to green, as shown in Figure 2-21.

% Note: The using internal crossover parameter is not applicable when configuring a mix
stage using the RMU.

LFEchamnels [ 1 |

Figure 2-14 Populate Parameters (Screen Wall)

Dolby Atmos® Designer User’s Manual I



Using Dolby Atmos Designer

2. Enter the desired parameters for the screen wall.

To enable the use of internal crossovers (CP850 only), your unit must have the required
enablement installed. For information on obtaining enablements, refer to the Dolby
Atmos Cinema Processor CP850 Manual.

If your CP850 is enabled for internal crossovers, you can click the using internal
crossover box and then select 2-way, 3-way, or 4-way in the drop-down menu, as shown
in Figure 2-15. Crossovers are indicated by an icon.

Figure 2-15 Configuring Crossovers (CP850 Enabled Units Only)

In this screen and in all of the populate screens, you can click the apply button Sl at the
upper-left corner to confirm your settings and all the screen tab icons turn green (see
Figure 2-21), which indicates that you entered complete and valid data. However, you can
wait until you enter information in all of the populate screens and then click the apply
button.

To undo your settings, click the cancel button [Jllff]. This button changes to a discard
button and you have an option to apply or discard your settings.

discard = You have unapplied changes

Figure 2-16 Apply or Discard Settings After Clicking Cancel

Note: If you enter and apply settings and then exit (or quit) Dolby Atmos Designer, a
prompt appears asking whether you want to save your configuration.
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Designing a New Configuration

3. Click the left & right walls tab to enter the respective parameters, as
shown in Figure 2-17.

Figure 2-17 Left and Right Walls Parameters

4. Enter the desire left and right wall parameters in the respective fields.

5. Click the booth wall & bm tab _ to enter the parameters for the booth wall
and bass management subwoofers.

Figure 2-18 Booth Wall and Bass Management Parameters
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Using Dolby Atmos Designer

6. Click the floor & ceiling tab to enter the respective parameters.

If the floor is flat, retain the default floor settings (0.000 m). If the ceiling is flat, enter
the ceiling elevation at the screen for all three values.

Figure 2-19 Floor and Ceiling Parameters

If you want to use the pairing feature, click the pairing tab . You can pair
loudspeakers within the same zone and region (driven by a single signal) to jointly
optimize for uniform coverage, power efficiency, spatial resolution, and system
complexity. The signals are distributed to each loudspeaker without phase, level, or
delay differences, and can be driven by a single amplifier channel.

Figure 2-20 Pairing Parameters

Caution: Adding a pair in a previously configured room clears all the routing, speaker
assignment, and bass management parameters.
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Designing a New Configuration

7. Click the apply button to confirm all of your populate entries, or click the cancel
button to undo your entries.

8. To save your entries, click save in the file menu, then follow the onscreen instructions
to name and save your file to the desired location, and click yes in the confirmation
dialog. To display a summary of your entries, click the summary tab.

If you enter valid parameters, the respective icons change to green. If any of your
parameters are invalid, their icons are red and an error message appears. In such a case,
you must enter valid settings. Clicking edit allows you to change any of your
previously saved parameters.

Edit Log Help

Figure 2-21 Summary of Valid Parameters

Dolby Atmos® Designer User’s Manual 15



Using Dolby Atmos Designer

2.5.2 Configuring a Speaker Location

To configure a speaker location:
1. Click the define button in the navigation bar at the left side of the screen to
display the corresponding parameters.

The speaker position parameters appears first, as indicated by the highlighted define

speaker tab .

Define buttons

X, y coordinate
entries

X, y speaker locations are in
relation to the plane

Figure 2-22 Configure Speakers

2. Click on a speaker icon at the left side of the screen.

3. Enter the x or y coordinates for the speaker locations in the respective fields:
* The x and y coordinates for the screen speakers are fixed (read only).
¢ The x coordinates for the left and right wall speakers are fixed.
* They coordinates for the booth wall speakers are fixed.

¢ The z coordinates for the overhead speakers are fixed.
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Designing a New Configuration

2.5.3 Assigning Arrays

To assign arrays:
1. Click the define button in the navigation bar at the left side of the screen, then
click the define array assignments tab [Fiaeama

The array assignments appear. Dolby Atmos Designer automatically assigns speaker
feeds to the arrays based on predefined rules. In this screen, the colors of the speakers
correspond to their array assignments.

File Remote Edit Log Help

array assignments

“B

screen speaker assignments

Right

surround speaker array assignments

Right wi

Figure 2-23 Array Assignments

2. To change the speaker assignments:
¢ (lick on a speaker to outline it with dashes.
®  C(lick the desired speaker assignment button.

To undo your array assignments, click the clear array assignments button

_ at the lower-right side of the screen.

Dolby Atmos® Designer User’s Manual 17



Using Dolby Atmos Designer

channel designated by a icon, and four bass management subwoofers designated by

Figure 2-24 shows a confiﬁation with five subwoofers (one Low-Frequency Effects [LFE]
. icons). Also shown are three crossovers designated by [F.{] icons.

Edit Log Help

array assignments

screen speaker assignments.

surround speaker array assignments.

Figure 2-24 Array Assignments (Five Subwoofers)
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Designing a New Configuration

254 Configuring the Speaker Assignments

To configure the speaker assignments:

1. Click the define button in the navigation bar at the left side of the screen, then
click the define speaker assignments tab [,

2. The speaker assignments appear.

e Edit Log Help

Figure 2-25 Configure Speaker Assignments

3. To select a speaker, click on its icon at the left side of the screen. You can also draw a
marquee around a group of speakers of the same type (for example, surrounds) and
edit the parameters for that group, except when you enter the x and y coordinates for
a speaker location (as described in Section 2.5.2).

If you click on a speaker to select it, a dashed outline appears around the speaker. To
add or remove the same type of speaker, press <Ctrl> on a PC (or <Command> on a
Mac) while you click on it. Red outlines displayed around a speaker indicate an
unconfigured speaker, or a speaker missing critical information. In addition, error
messages may appear in red near the bottom of the screen (for example, when a
parameter value is not within the proper range).

Caution: Changing the configuration in a previously acquired room clears all acquisitions,
speaker assignment, routing, and bass management parameters.
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Using Dolby Atmos Designer

4. To assign a speaker profile, click in the change type field to display a drop-down
menu.

5. Select generic, passive, active, external processor (for screen speakers and
subwoofers), or internal crossover. For the RMU, the external processor and internal
crossover parameters are not applicable.

speaker assignments

Figure 2-26 Change Speaker Type

When you select passive, two fields appear where you can select a speaker and
amplifier from the respective drop-down menus, as shown in the following figure.
For active, only a speaker field appears. The speaker and amplifier profile database is
prepopulated with read-only profiles. If your speaker model is not in the database, you
can add a profile and edit it accordingly, as described in Section 2.6. Some speaker
locations are fixed (read only), as described in Section 2.5.2.

speaker assignments

label Lss 1
type <generic

speaker

amplifier

Select
speaker

Figure 2-27 Select Passive Speaker (Surround Speaker Example)
6. Click apply to confirm your selections and display the manufacturer speaker and

amplifier specifications. Repeat this step each time you select and assign a single
speaker or a group of speakers.

SURRQUND

Figure 2-28 Passive Speaker and Amplifier Specifications (Surround Speaker Example)

20 Dolby Atmos® Designer User’s Manual



Designing a New Configuration

For screen and Low-Frequency Effects (LFE) channels, an external processor (crossover)
parameter is provided.

Figure 2-29 Select External Processor (LFE Subwoofer Example)

To assign a crossover profile, click on a speaker that you specified as a crossover in the
populate screen, then select a crossover profile. You can assign only the crossover type that
you specified (2-way, 3-way, or 4-way). The following figure provides an example for a
2-way crossover.

Figure 2-30 Select Crossover

7. Click apply to confirm your selections and display the manufacturer processor
specifications. Repeat this step each time you select and assign a single subwoofer or a
group of speakers.

In addition, if you check show me profiles of similar equipment, this indicates whether
a specific .dad profile on the CP850, RMU, or storage device exists in your database. If
not, and you need that profile, you can grow your database by pulling the profile and
importing it into your database. For information on importing profiles, see Section 2.6.

Figure 2-31 External Processor Specifications
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Using Dolby Atmos Designer

2.5.5 Configuring the Routing Parameters

To configure the routing parameters, click the define button in the navigation bar at
the left side of the screen, then click the define routing tab m

The routing parameters appear. In this screen, you can apply Automatic Routing or
Manual Routing.

Edit Log Help

routing

dear al routings

Figure 2-32 Routing Parameters (Three Subwoofers, No Crossovers)

Edit Log Help

routing

dear al routings

Figure 2-33 Routing Parameters (Five Subwoofers, Three Crossovers)
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Automatic Routing

Automatic routing follows these predefined rules:

* The automatic assignment for the screen is Left, Right, Center, and LFE.

e The automatic assignment for the left and right side and ceiling surrounds is
screen to booth.

* The automatic assignment for the rear surrounds is left, right, left, right, left, right
until the system fully assigns the arrays.

To apply automatic routing;:

1. Draw a marquee around a group of speakers (within the gray area) to select them.
You can select speakers one at a time by pressing <Ctrl> (or <Command> on a Mac)
while you click on each speaker.

A dashed outline designates each of the selected speakers.

Figure 2-34 Select Group of Speakers for Automatic Routing
2. In the automatic routing pane, for a CP850, select the number of analog outputs you

are using from the analog outputs to use drop-down menu. For an RMU, verify that
this parameter is set to 0, as the RMU does not have any analog outputs.

analog outputs to use |0

DGO O LN s L p ._.l

Figure 2-35 Select Analog Output for Automatic Routing
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3. Select the output where you want to start the automatic routing operation in the auto
assign from output drop-down menu.

Figure 2-36 Assign First Output for Automatic Routing

4. Click the apply automatic routing button. R

apply automatic routing

The automatic routing operation begins routing incrementally from the first speaker in
the speaker group (according to the previously described automatic routing rules)
until the process is completed.

Manual Routing

To apply manual routing:

1. Click on a speaker to outline it [E&4.

2. In the manual routing pane, select an output that corresponds to the appropriate
routing in the physical output drop-down menu. Alternatively, you can type the
number of the desired output on your keyboard and press <Enter>.

incremental routing ||

sical output | 23 - digital

Figure 2-37 Select Output for Manual Routing

3. Repeat steps 1 and 2 for each speaker.
You can clear all of your selections by clicking the clear selected routings button.

24 Dolby Atmos® Designer User’s Manual



Designing a New Configuration

Incremental Routing

To enable this feature:

1. Click the incremental routing checkbox in the manual routing pane.

2. Select the starting output number in the incremental routing start drop-down menu.

Note: To enable the incremental routing feature for the RMU, you must select only
% digital outputs.

3. Click the first speaker in the routing display to assign that output number.
4. Click the next speaker to assign the next output number in order.
5. Continue clicking on speakers to assign additional outputs.
You can clear all of your selections by clicking the clear selected routings button.

incremental routing [v]

incremental routing start

nalog
nalog
OC

og
10 - analog

Figure 2-38 Select Starting Output for Incremental Routing
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2.5.6 Configuring the Bass Management Parameters

To configure the bass management parameters for subwoofers, click the define
button in the navigation bar at the left side of the screen, then click the define bass

management tab .

Select speakers one at a time or draw a marquee around a group of speakers.
Assign the speakers to the bass management subwoofers.

Assign a bass management frequency to the group.

Click the apply button.

W N =

File Remote Edit Log Help

“B

Figure 2-39 Configure Bass Management
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2.5.7 Entering the Room Information

To enter this information, click the define button in the navigation bar at the left side
of the screen, and then click the define room tab.

Figure 2-40 Enter Room Information Example

2.5.8 Configuring the Advanced Parameters (CP850 Only)

To configure these parameters, click the define button in the navigation bar at the left
side of the screen, and then click the define advanced tab to verify the speaker limiters
setting.

A message indicates that we do not recommend checking the speaker limiters disabled box
for the CP850), as this disables speaker limiters. In addition, this message explains that if the
box is checked, you can uncheck it to reenable speaker limiters. When pushing to the RMU,
limiters are automatically disabled whether the checkbox is checked or unchecked.

ad\-'anced.k

disable speaker limiters. This is not the recommended configuration.

Figure 2-41 Advanced Tab Speaker Limiters Information
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2.5.9 Tuning the Room

To tune the room (running AutoEQ):

1. Click the tune button in the navigation bar at the left side of the screen to
display the tuning screen.

warning: reference signal needs to be calibrated

Click to
connect
(CP850 only)

Figure 2-42 Tuning Screen

2. To connect to a CP850, click the disconnected button at the lower-right corner of the
screen (or in the Remote menu), and then click connect. For Microsoft Windows, make
sure that the Octa-Capture audio buffer size is set to 512 for the driver settings.

For an RMU, do not click the disconnect button. By default, the RMU is connected to
Dolby Atmos Designer, because Designer is running on the RMU. Proceed directly to
step 5.

+* disconnected -

Connect

Figure 2-43 Click to Connect to CP850

A warning message indicates that connecting interrupts theatre audio.

MTERRUPT theatre audio.

Figure 2-44 Connect Warning
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3. Click Yes to proceed.
A dialog box requests an IP address for your CP850.

4. Enter the CP850 IP address, and click connect in the dialog box.

Enter CPB50 IP:

Figure 2-45 Enter CP850 IP Address
Once connected, the disconnected button in the tuning screen changes to a connected

button and you can view the CP850 software version and IP address by clicking on this
button. The tuning screen is now activated.

fader level 7.0

‘acquisition settings

Connected

Figure 2-46 Connected to CP850

5. Select the number of microphone inputs you are using for the calibration. An on/off
button below any meter in the microphone input levels section indicates whether the
system will use the corresponding microphone input for the acquisition process. You
cannot disable microphone 1.

6. Click the calibrate reference signal button.
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The Reference signal adjustment instructions appear.

Figure 2-47 Reference Signal Adjustment Instructions

Unmute the signal by clicking the unmute button.

The red unmute button changes to a gray mute button. This generates pink noise
from the center speaker. Using an SPL meter, adjust the fader icon until the sound
pressure level from the Center channel is 85 dBC.

Click OK.

A message prompts you to adjust the amplifier gains. Read the message, then click the
close button in the dialog box.

We recommend that you adjust the output gain of each speaker to optimize the
dynamic range of the system:

a. Turn on noise by clicking the check box at the top of the AutoEQ screen.
b. Select pink noise as the test signal.

c. Select the speaker feed by clicking the desired speaker icon on the left side of
screen.

Measure the C-weighted SPL at the reference position in the room.
Adjust the amplifier gain until the speaker output level is 85 dBC.
Note the input gain adjustment.

Repeat the preceding steps for each speaker.

T @ ot oo

Once the gain adjustments are complete for each speaker, turn off the pink noise.

Note: Set the LFE channel to +10 dB in-band gain (approximately 91 dBC SPL), and set

bass management subwoofers to 0 dB in-band gain (approximately 81 dBC SPL).

10.
11.

12.

13.

After setting all the speaker feeds to 85 dBC SPL, click the amp gain button |[Ered-

Select a speaker feed by clicking a speaker on the left side of the screen. A data entry
field appears with up/down arrows.

Adjust the amplifier gain using the up/down arrows, based on the input gain
adjustment. (See step 9-f.)

Repeat the preceding steps for each speaker based on the input gain adjustment.
(See step 9-f.)

30
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pink noise

acquisition settings

Figure 2-48 Adjusting the Amp Gain

14. Click the x-curve tab to display the x-curve parameters and modify, if desired.

use defaults |:|

corner freg. B (Hz)

slop

Figure 2-49 X-Curve Parameters

15. Set the boost-level frequencies.

Boost limits define the point where no boost above 0 dB is applied to frequencies above
and below the high and low limits for a speaker or an array feed. The system
automatically assigns default boost-limit frequency points to each speaker and array
feed. To change the boost-limit frequency:

a. Select a speaker at the left side of the screen, or draw a marquee around a group
of speakers to edit the parameters for that group.

b. Select the AutoEQ results tab.

c. Edit the boost-limits value by typing in a value or by using the up/down arrows.

= Note: Avoid setting boost limits to frequencies above or below the bandwidth limits of
% the speakers (+3 dB points) to avoid excessive boost where the output of the
speaker begins to rapidly decrease.
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AutoEQ results

——Edit boost limits

Figure 2-50 Set Boost Level by Clicking the AutoEQ Results Tab

16. Click the record q button. Be sure you have 4 GB of available storage
space on your system, or the recording can freeze during the process.

17. At the prompt, enter a file name and click save to save your file if you have not done
so already.
Recording begins immediately. During a measurement, the speaker being measured
flashes red and a signal is displayed on the input level meter. In addition, a progress
bar appears at the bottom of the screen and the speaker being acquired is displayed
below the progress bar.

File Remote Edit Log Help

Figure 2-51 Speaker Measurements
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When the speaker feed measurement is completed, the system automatically starts
processing data. Once processed, a speaker icon turns green, which indicates that the
data is in the required range. A red speaker icon indicates a low signal-to-noise ratio,
and the data may be invalid. During the EQ process, you can view real-time results by
clicking the AutoEQ results tab.

AutoEQ resutts

3¢ oqfiter | x-curve | mic 11 mic 21 mic 3 | mic 41 mic §1 mic 6| mic7 | mic8

Figure 2-52 Processing Speaker Feed Data (Showing Real-Time AutoEQ Processing)

After speaker feed processing, the system automatically begins array measurements.
The arrays being measured flash red, measured arrays appear in yellow, and a signal
appears on the input-level meters. Array icons with no color indicate that there is no
measurement data present. Some speakers are assigned to multiple arrays. Array icons
that are half green and half yellow indicate that one of the arrays is processed and the
other is not. Array icons that are half gray and half yellow indicate that one of the
arrays contains data, while the other does not. Array icons that are completely green
indicate that the array acquisitions were processed.

EEEEEEEEEEEN
EEEEEEEEEEEN
NNNNNMYNNNNN

Figure 2-53 Array Measurements
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At the end of the entire process, a message indicates that AutoEQ is completed.

Note: If the AutoEQ completed message does not appear, there may be some issues with

the acquisition process or other related parameters.

18. Click OK.

Once the equalization process is complete, we recommend that you inspect each
speaker feed and array feed to confirm that the equalization and levels are
appropriate:

* Select a speaker feed by clicking a speaker icon on the left side of the screen.

* Navigate to the AutoEQ results tab.

* Observe the gain value for each speaker feed and equalization curve.

e If the gain or equalization seems incorrect for a speaker feed, you can:

a. Remeasure the speaker by clicking on a speaker at the left side of the screen, or
select multiple speakers by pressing <Ctrl> and clicking on the desired speakers.
You can also draw a marquee around a group of speakers. Remeasure by pressing
the rec button.

b. Update the speaker by clicking on a speaker at the left side of the screen, or select
multiple speakers by using the methods described in step a. Change a value, such

as a boost-limit frequency or x-curve parameter. Select update to reprocess the
data with the edited value.

Note: If you update a surround speaker, the system remeasures the array to which the

speaker feed is assigned.

19.

20.

21.

For a CP850, select Push to CP850 from the Remote menu. Proceed to step 20.

For an RMU, Click Push to RMU from the Remote menu. When prompted, save the
RMU-compatible .dac file to disk. Be sure to give it a different name than the one you
specified for step 19. The .dac file is now ready for loading into the RMU for various
Dolby Atmos authoring tasks. For information on loading a .dac file into the RMU, see
the Dolby Rendering and Mastering Unit for Cinema User Manual.

Click Yes to continue.

If you are connected to a CP850, the system pushes the Dolby Atmos configuration to
your unit. If you are not connected to a CP850, you must enter an IP address at the
prompt before the system pushes the configuration to your unit.

A warning message with a backup prompt appears. You can ignore this warning and
click overwrite. However, if you need to back up the existing configuration file on the
CP850, use the CP850 web client, as described in the settings management section of

the Dolby Atmos Cinema Processor CP850 Manual.

When the system writes the Dolby Atmos configuration file to the CP850, a
confirmation dialog box appears. Click OK.

Click Save As in the File menu to save your .dad file to the desired directory on your
PC or Mac as a backup.
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Editing Crossovers (CP850 only)

When connected to the CP850, you can edit a crossover profile in real time during the
tuning operation:

1. Click the crossover tab, click on the desired speaker at the left side of the screen, and
then click the unlock button to unlock the crossover profile fields. The
unlock button changes to a lock button [, which you can click to lock your
profile after editing.

Click crossover tab

Click

Click unlock

speaker

Frequency
response
graph

Crossover
profile
fields

Figure 2-54 Unlocking the Crossover Profile

The filters are implemented in real time when pink noise is on.

2. Click the on check box to turn on pink noise.

pink noise

Figure 2-55 Turning On Pink Noise

@

Route pink noise to the speaker by clicking on the speaker at the left side of the screen.

b

Select a way filter to edit by clicking the low or high tab for a two-way loudspeaker;
low, mid, or high for a three-way loudspeaker; and low, low mid, high mid, or high for a
four-way loudspeaker. The color coding corresponds to the plot in the frequency
response graph.

Figure 2-56 Selecting a Crossover Way to Edit
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5. Adjust the gain and delay using the up/down arrows or by editing the text in the
respective data entry fields.

g=in | 0.0 dB

delay |_ 0.00 ms

Figure 2-57 Adjusting Crossover Gain and Delay

6. Change the polarity by selecting or - from the

drop-down selector.

7. To mute a way click the _ button. The mute button turns red
and the frequency response plot clears from the graph. To unmute the way, click the
mute button again.

8. Add afilter by clicking the high pass button, low pass button, parametric button, high
shelf button, low shelf button, or all pass button.

fiters high pass low pass  parametric  high shelf  low shelf  all pass

Figure 2-58 Adding a Filter

9.  When pink noise is enabled, you can bypass a filter (without deleting it) by clicking
the =Bl button.

Note: You can use the bypass function only when pink noise is turned on. The bypassed
filter is enabled when pink noise is turned off.

10. Adjust a filter frequency, gain, or bandwidth using the up/down arrows or by editing
text in the data entry fields for each filter.

11. Adjust the high pass filter or low pass filter type and slope values using the respective
drop-down selectors. To change these parameters when pink noise is turned on, you
must mute the output.

frequenc
frequenc

frequency | 1000.0

Figure 2-59 Adjusting Filter Frequency, Gain, Bandwidth Filter Type, and Slope

You can remove a filter by clicking the “ button.
Copying and Pasting Crossover Settings
During the tuning operation (with the crossover profiles unlocked and pink noise turned

off), you can copy and paste crossover settings from one speaker to another by
right-clicking on the source and destination speaker icons.

Figure 2-60 Copying and Pasting Crossover Settings
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2.6 Viewing and Editing the Database

To view and edit the database, click the manage button in the navigation bar at the left
side of the screen. In this screen, you can view, add, remove, and customize speaker (active
and passive), amplifier, external processor, and crossover profiles and view the.dad profiles
in your database.

File Remote FEdit Log Help

8

Figure 2-61 Manage Parameters

2.6.1 Adding a New Profile

To add a profile to the database:

1. Click the edit = button at the upper-left section of the screen.

active speaker

Figure 2-62 Click Edit to Activate Database Modifications
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The activated database screen displays add ., remove ., and duplicate .buttons.

Speaker, amplifier,
ectrrpetey processor, and

Add, crossover settings
remove,

duplicate tabs
buttons

Figure 2-63 Activated Database to Add New Profile

When you click the active speaker, passive speaker, amplifier, external processor, or
crossover tab and then click the add . button, you can add a new profile from scratch. If
your new profile is similar to an existing profile, you can modify the existing profile.
However, if you want to retain the original profile, we recommend duplicating the existing
profile and then modifying it, as required (see Modifying a Profile).

To delete a profile, click the remove .button.

5] Active Speaker 2] Passive Speaker

Cancel

7| Amplifier

7] Bxternal Processor

Cancel

5 Crossover

Cancel

Figure 2-64 Adding New Profiles
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Adding a Crossover Profile to the Database (CP850 Only)

To add a new crossover profile to the database:

1. ek the crossover | Y

2. Click the edit button = , then click the add button . , and enter the required
information in the Crossover dialog box, and click OK.

T Crossoner B ==

way count [2,4] |

Figure 2-65 Enter Crossover Information

In the crossover tab screen, you can view the crossover frequency response and edit
any of the current crossover profiles by clicking in the respective fields. You can also
delete and duplicate crossover profiles.

4(22/2016 7:!

Edit
crossover
settings

Figure 2-66 Crossover Tab Screen
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@

Select a way to edit by clicking the low or high tab for a two-way loudspeaker; low,
mid, or high for a three-way loudspeaker; and low, low mid, high mid, or high for a
four-way loudspeaker. The color coding corresponds to the plot in the frequency
response graph.

Figure 2-67 Selecting a Crossover Way to Edit

4. Adjust the gain and delay using the up/down arrows or by editing the text in the
respective data entry fields.

in | 0.0 dB

delay | 0,00 ms

Figure 2-68 Adjusting Crossover Gain and Delay

5. Change the polarity by selecting or - from the

drop-down selector.

6. Add a filter by clicking the high pass button, low pass button, parametric button, high
shelf button, low shelf button, or all pass button.

fiters high pass  low pass  parametric  high shelf  low shelf &l pass
Figure 2-69 Adding a Filter

7. Adjust a filter frequency, gain, or bandwidth using the up/down arrows or by editing
text in the data entry fields for each filter.

8. Adjust a high pass filter or low pass filter type and slope from the drop-down
selectors.

type | Butterworth slope| 12 dB
type | LinkwitzRiley slope| 24 dB

octave

Figure 2-70 Adjusting Filter Frequency, Gain, Bandwidth Filter Type, and Slope

You can remove a filter by clicking the n button.
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Modifying a Profile
To modify an existing profile, click the desired profile, then double-click on the parameters
you want to change and enter the desired settings. In this case, you do not retain the

original profile.

To duplicate and modify an existing profile, click the profile, click the duplicate button
- and then edit the desired settings. In this case, you retain the original profile.

Boxes with checkmarks next to a profile indicate a customized (modified) profile with the
date modified displayed to the left of the checkbox. This distinguishes a default profile from

a user-customized profile.

Values displayed in red indicate that the data is out of range.

active speaker

Acheran-| er (1) v 8 5/5/2016 6:55:5...

DDNOOEEEEE

Figure 2-71 Modifying a Profile

To add your new profile to the database, click apply, enter the required parameters in the
Update Database dialog, then click OK, and then click Update. To undo your settings, click
the cancel button [JEll]. This button changes to a discard button , and you have an
option to apply or discard your settings.

7| Update Database

name

note:

Figure 2-72 Updating the Database with a New Profile

The duplicate model name increments by one. In addition, the content version in the
Preferences screen also increments by one.
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2.6.2

2.6.3

Viewing and Importing .dad Profiles

If you open a . dac file or .dad file or you pull a configuration from the CP850 or RMU, you
can view the profiles assigned to the loudspeakers by that configuration. You can filter by
type by clicking the respective tab in the dad profiles section of the manage database screen,
as shown in the following figure for a flat 4-way crossover profile. If the currently loaded
profile does not exist in your database, you can import that profile by selecting Import dad
profiles in the File menu.

Figure 2-73 Viewing a .dad Profile
Additional Database Functions

The File menu and the Preferences screen provide additional database functions.

File Menu

You can use the File menu to perform additional database functions, as shown in the
following figure.

Ctrl+N
Ctrl+0

Ctrl+5

erwrite database

Import database i
Database functions
database

Import dad profiles

Figure 2-74 File Menu Database functions

* Overwrite database: Opens a database (.db) file, and uses it to replace your current
database.

* Import database: Imports a .db file, but replaces only those records that do not
currently exist in your local database.

* Export database: Copies your entire local database to an external disk.

* Import dad profiles: Copies the currently loaded configuration, and merges it with
your existing database. This function copies only those files that do not currently exist
in your database.
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Preferences Screen

You can also perform the previous File menu database functions (except for Overwrite
database and Import dad profiles) and display additional database information by selecting
Preferences in the Edit menu (or in the Dolby Atmos Designer menu on a Mac).

Database information

Database functions

Figure 2-75 Preferences Screen Database Functions

In addition, you can reset your database to the factory defaults in the Preferences screen.
When you select the reset button [ SRl in this screen, the system displays a caution
message dialog box that reminds you to export your database to retain your custom

profiles before resetting to factory defaults. When you click the Reset button in the
dialog box, your database returns to the factory defaults.

defaults. To

our duplicates

Figure 2-76 Reset Database
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